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Front panel  

  
 

 

 

1. The power switch is a button. When the power is off, press the power switch to 
 turn it on. Press again to power off. 

2. The screen will display the current input channel, encoding format and sample rate, 
volume and other status. 

3. The D-pad can be used for input channel selection and volume adjustment; or select 
and adjust various menu options in the menu state. 

4. Press the Menu button to enter or exit the menu.  
 

 

 

 

Rear panel  

 

  

 

* When operating the international voltage switch, please be sure to set both switches to the 

same voltage at the same time, otherwise the power transformers of the X26pro will be damaged 

after power-on. 
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Display and menu   

1. The X26pro uses an OLED screen for real-time status display and functional 

operation. The following graphic shows the status of the main page of the screen. 

 

           

 

2. Digital input channel selection: 
The X26pro has a total of 6 input channels. In the display state of the main page, 

short press the function button, you can select the current input channel in the 

order of COAX——AES——USB——IIS——OPT——BT. Bluetooth device name: GUSTARD BT 

 

3. VOLUME： 

When the screen is in the state of the main page, the D-pad's up and down buttons 

can be used to directly adjust the digital volume attenuation function of the 

X26pro.  

The down button of the D-pad is the attenuation volume, and the up button of the 

D-pad is for increasing the volume. The volume can be adjusted from 00dB to -90dB 

for a total of 90 digital volume positions.    

 

4. Settings menu 
When the screen is in the main page state, press the menu button to enter the 

settings menu. 

In this state, press the up and down buttons of the D-pad to switch the menu items 

to be modified according to the direction. The left and right buttons of the D-

pad are used to adjust the currently selected menu item.  

When the screen is in the setup menu state, pressing the menu button again will 

return to the main page. 

The current menu item is switched by the movement of the arrow, in order: 

—PCM filter 

—DSD filter 

—REF CLOCK SELECT 

—NOS mode  

—Phase invert 

—Brightness 
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5. Menu items’ functions： 

The following is a detailed introduction of each menu item:     

 

a. PCM FILTER（PCM digital filter）：   

 
The X26pro uses Gustard's proprietary high-performance PCM digital filter algorithm, with a 

total of three types of PCM digital filters to choose from. 

When this menu item is selected, pressing the right button of the D-pad will cycle through the 

VIVID - GENTLE - COMPOSITE sequence, and press the left button of the D-pad to reverse the 

loop. 

The VIVID filter is similar to the traditional digital filter's FAST roll-off type, which has 

excellent ringing characteristics, minimal pre-ringing, and fast-converged post-ringing. The 

VIVID filter provides very realistic and accurate detail, sound field and sound reproduction. 

We strongly recommend using this digital filter when listening to most music genres. 

GENTLE is similar to the traditional digital filter SLOW roll-off type, which sounds more 

elegant and relaxed. 

COMPOSITE is a composite digital filter. Its ringing characteristics are mainly post-ringing 

and have a very good sound. 

 

 

b. DSD Filter（DSD digital filter）：    

 

The X26pro has a total of 4 DSD filter cutoff frequencies that can be adjusted. 

When the menu item is selected, pressing the right button of the D-pad will cycle through the 

order of 47K - 50K - 60K - 70K, and press the left button of the D-pad to reverse the loop. 

Please adjust according to the different DSD sampling rate of your playback. For example, if you 

listen to DSD64 (2.82M) most, it is recommended to use 47K. 

Choosing a larger bandwidth means more high frequency details. 
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c. REF CLOCK (Reference Clock Selection):    

 

GUSTARD-K2, low noise clock synthesizer. With ultra-low phase noise, the 

synthesized clock achieves femtosecond ultra-low jitter performance, and can 

directly transmit the near-end performance of the reference clock. Benefit from 

the high-precision divider, the precision of the synthesized audio clock reaches 

the ppb level. Benefiting from this, the master clock of the ES9038PRO decoder 

chip built in X26pro is also controlled by the K2 high-precision lock synthesizer, 

which directly works in super-synchronous mode to synchronize ASRC re-sampling, 

and no longer depends on ASRC to guarantee performance (100M clock is no longer 

needed). 

REF CLOCK can select INT. internal reference, use the internal flying seconds. 

Or select EXT. to select the external 10M reference source, you can connect 

GUSTARD C16 or C18 to reference the 10M master clock. 

 

When the EXT mode is selected and the external 10M is correctly locked. After 

exiting the menu, the main screen will display EXT. 

 

When the external clock is selected, if the external clock is lost or the deviation 

of the external clock is greater than + -150 ppm, EXT ERR will be displayed.  
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d. NOS MODE（Non-OverSamlping Mode）：   

 
As PC performance continues to evolve and the performance of oversampling digital filter 

algorithms built into the audio player software advances, CAS audiophiles can use high-

performance PCs for digital oversampling filter processing. Then, digital audio stream signals 

that have been processed by the oversampling digital filter are directly sent to the DAC chip 

by using a digital audio transmission interface such as USB audio that supports high sampling 

rate. This provides a higher sound quality and a different listening experience. 

In other words, this means that you need to bypass the digital filter integrated in the DAC. 

The X26pro can be set to bypass the built-in high-performance oversampling digital filter so 

that the sound of an external high-performance digital filtering algorithm can be easily heard. 

There are 2 modes available for this menu item: 

1.OFF: Do not open the NOS mode, that is, use the built-in high-performance super-

sampling digital filter of X26pro. 

2.ON: Turn on the NOS mode. 
*In NOS mode, due to the design of the ESS chip, when directly playing back a lower sampling rate 

such as 44.1kHz, the output analog signal frequency bandwidth will only be 8kHz.  

Therefore, it is not recommended to play back CD format in NOS mode. 

   

e. PHASE INVERT（Analog output phase inverting switch）：   

 

This function has two options: DISABLE (RCA positive phase output - XLR American standard) and 

ENABLE (RCA inverted output - XLR Japanese / European standard) optional. 

When this function is DISABLEd, the RCA output of the X26pro is positive phase, and the XLR 

balanced output is the American standard polarity output, which is 1 ground, 2 hot, and 3 cold. 

When this function is ENABLEd, not only the RCA output is the inverting output, but the XLR 

balanced output will be the Japanese/European standard polarity output, which is 1 ground, 2 

cold, and 3 hot. 
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f. BRIGHTNESS（Screen brightness）：   

 

This menu item adjusts the brightness of the OLED screen, and a total of 8 screen brightness 

levels can be adjusted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 - 8 - 

IR Remote control 

 
     * X26pro uses the new remote control, please press and hold the DAC key for more 
      than 3 seconds to enter the DAC operation mode. AMP and STREAM modes are used to 

       control other types of GUSTARD products 
① Mute button: In the non-mute state, press this button once, the X26pro will be muted; press this button again 

to unmute. 

 

② Menu button: Press this button once to enter the setup menu of the X26pro, press this button again to exit 

the setting menu.   

 

③ D-pad and OK button：After entering the setting menu of the X26pro, use the up/down of the D-pad to switch 

the function to be adjusted, and adjust the options by left/right. Press OK to confirm the result and return 

to the main page. 

 

④ Back button: Returns to the main page state.  

 

⑤ Volume minus button: When the X26pro is in the main page state, press this button to decrease the volume. 

 

⑥ Volume plus button: When the X26pro is in the main page state, press this button to increase the volume. 
 

Note: ● The operating distance varies depending on the angle. ● If there is something between the remote control and the IR sensor, 

it may not operate normally. ● If the remote control will not be used for a long time (one month or longer), remove the battery. ● If 

the battery Leaking, please thoroughly clean all the residues in the battery compartment and install new batteries. ● When using other 

devices controlled by infrared rays, using this remote control may operate these devices by mistake. 
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Windows driver installation 

 

* The unit's accessories contain a CD containing the GUSTARD USB Audio driver. 

This driver can also be downloaded from our official website http://www.gustard.cn 

 

* This driver supports Windows 7 (SP1 and newer); Windows 8; Windows 10 

 

1. For users who use a desktop PC to connect to the X26pro, it is recommended to use 
the native USB2.0 interface.It is also highly recommended to use the USB port on 

the back of the chassis. Because the USB port on the rear panel of the chassis is 

directly connected to the motherboard. The USB port on the front of the chassis 

is connected to the motherboard with an extension cable, which has a certain 

negative effect on high-speed signals. 

 

2. Please connect the X26pro to the computer with the USB cable, then turn on the 
power of the X26pro. The computer will prompt you to find new hardware and try to 

set the device. If you don't see this prompt, please try to replace other USB 

ports or manually restart X26pro. 
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3. Open the CD and double-click to run the Gustard_USBAudio_v1A_2018-10-15_setup.exe 
program. 

If the "User Account Control" window appears, click "Yes". 

 

 

4. Click the next or install button as prompted. 
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5. When the installer checks the device, if there is a red text prompt: Setup requires 
that the device is..., please restart the GUSTARD X26pro or re-plug the USB cable. 

       

        
 

 

6. The figure below shows the screen for successfully installing the driver. Click 
Finish to complete the installation. 
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DSD playback settings using foobar2000 

1. Open the folder foobar2000_DSD_0.7.X, double-click to run ASIOProxyInstall-

0.7.2.exe, and then click next or install to complete the installation. 

             
 

2. Run Foobar2000. Click File -> Preferences. 
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3. Click on "Components" on the left and click on "Install" on the bottom right. 

 

 

 

Use the mouse to select two files at the same time, or press Ctrl to select two 

files at the same time. Then click "Open". 
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Two rows of component information will be added to the component list, followed by 

"Apply". 

 

The window shown below will pop up and click "OK". Then Foobar2000 will restart. 

 

4. Click File -> Preferences again. 
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5. Expand Playback - Output - ASIO, and double-click foo_dsd_asio. 

 
6. In the "foo_dsd_asio v0.7.2" window. Select "Gustard USB Audio" from the drop-down 

menu of the first line ASIO Driver. 

Select "ASIO Native" from the drop-down menu in the second line of the DSD Playback 

Method. 

For other settings, please make the same selection according to the red box in the 

figure. Then click the X in the upper right corner to exit. 
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7. Click "Output" on the left, then select "ASIO:foo_dsd_asio" from the drop-down menu 

for "Device" on the right. 

 
8. Then click on Tools -> SACD and select "DSD" from the drop-down menu in the Output 

Mode on the right. Finally click "OK" below to complete the setup. 
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DSD playback troubleshooting for Foobar2000 

1. Q: Why does my foobar2000 preference window play (Playback) -> Output (Output) 
does not show ASIO? 

        

A: Because you don't have the ASIO component installed. Drag the foo_out_asio.fb2k-

component file from the foobar2000_DSD_0.7.X folder to the space in the box to 

the right of the component option in the preference window of foobar2000, then 

click the "Apply" button in the lower right corner. Click OK in the Restart 

foobar2000 dialog that pops up at this time. After restarting foobar2000, you can 

find the ASIO option. 

 

 

 

 

 

 

 

 

 

 

 



 - 18 -

2. Q: Why is there no SACD in the tool options in my foobar2000's preference window? 
 

A: Because you don't have the SACD component installed. Drag the 

foo_input_sacd.fb2k-component file from the foobar2000_DSD_0.7.X folder to the 

space in the box to the right of the component option in the preference window of 

foobar2000, then click the "Apply" button in the lower right corner. Click OK in 

the Restart foobar2000 dialog that pops up at this time. After restarting 

foobar2000, you can find the ASIO option. 
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3. Q: I have installed the above two Foobar2000 components. Why do I see an error 
window like the one below when I play the DSD file? 

 

    

 A: Because the version of your ASIOProxy conflicts with the version of the SACD 

decoding component. The correct version is shown below, all of which are 0.7.X. 
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Some users use the old version of foobar2000, and its SACD decoding component 

stays in the 0.6.X version. If the ASIOProxyInstall-0.7.2.exe program is installed, 

the version of the foo_dsd_asio window is 0.7.2. This creates a conflict with the 

SACD decoding component. 

    

There are two solutions. 

One is to update the version of the SACD component, and the installation method 

is consistent with the solution to the second problem. However, some versions of 

the foobar2000 component are locked and cannot be replaced. Please reinstall the 

new version of the official original Foobar2000 to solve the problem. 

Second, if you are not willing to reinstall foobar2000, you can install the old 

version of ASIOProxy, such as ASIOProxyInstall-0.6.5.exe. Google search 

ASIOProxyInstall-0.6.5.exe to find the download link, which can also solve the 

problem. 
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Product specifications 

 

Sample rate supported by digital input channels: 

 

COAX ：PCM 16-24bit/44.1-192kHz；DSD DOP64 

AES  ：PCM 16-24bit/44.1-192kHz；DSD DOP64 

OPT  ：PCM 16-24bit/44.1-192kHz；DSD DOP64 

USB ：PCM 16-32bit/44.1-768kHz；DSD DOP64-DOP256；NATIVE DSD：DSD64-DSD512 

IIS ：PCM 16-32bit/44.1-768kHz；DSD DOP64-DOP256；NATIVE DSD：DSD64-DSD512 

BT Bluetooth 5.0 : PCM LDAC, AAC, SBC, APTX, APTX LL, APTX HD and other high frequency 

encoding, LDAC can achieve 24B / 96K high code transmission 

 

* USB input supported operating system：WIN7 SP1/WIN8/WIN10 32-64bit；macOS；Linux 

 

 

Analog output performance： 

 

Amplitude frequency response：20-20kHz /+-0.1 dB 

DNR： >128dB 

Crosstalk：-140dB @ 1kHz 

THD+N：<=0.0001%  @1kHz 

IMD：<0.0006%  @-1dBFs 

 

RCA Output level：2.5Vrms (VOLUME  00dB) 

Output impedance 100 ohms 

 

XLR Output level：5Vrms (VOLUME  00dB) 

Output impedance 100 ohms 

 

Other specifications： 

 

AC Power supply：AC 115V/230V  50/60Hz 

Power consumption：<60W 

Dimensions：Width 330mm * Height 65mm * Depth 260mm（Excluding protrusions） 

Weight：7Kg (including packaging) 
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Product Warranty: 

You will enjoy the 2-year free warranty and lifetime maintenance after the date 

purchasing GUSTARD’s X26pro product. 

 

 

* The manufacturer bears only the freights from Chinese mainland. Part of the freight 

and tax generated from overseas will be solved by the user with the dealer negotiation. 

 

Free Warranty Service 

GUSTARD X26pro from the purchasing date in the free warranty period, the user uses 

the product in normal, and the product fails due to component quality or manufacturing 

problems. 

 

Beyond the Warranty Service 

Belonging to one of the following circumstances, products are no longer provided 

warranty service. 

a. Products from the date of purchase has exceeded a predetermined warranty period. 

b. Model, barcodes and purchase date do not match the actual product and warranty 

card. 

c. Without GUSTARD technician permission, unauthorized modifications to the circuit， 

components or self-repaired product. 

d. Damaging caused by irresistible natural forces. 

e. Beyond the permitted use of environmental damage. 

f. Damaging due to incorrect use or improper storage. Including but not limited to: 

the voltage is too high to burn the circuits or components; Bumping and resulting in 

damaging the shell or internal; damaging due to water, oil, liquid and excessive 

dust; product oxidation or corrosion, etc. 

g. Beyond the warranty period, such as an individual component damage, appearance 

due to human damage, firmware modifications lead to unable to work by unauthorized 

users. GUSTARD commits to take reasonable maintenance fees (except large area 

components or circuit board burned beyond repair). Freight and maintenance costs, 

material costs are required the user to bear. 

 

 

 

 


